# Table of Contents

## Chapter 1: Introduction
- About SNAP PAC Brains
- I/O Processing
- Communications
  - PAC Project Software Suite
  - Other Communication Methods
  - Custom Software
- About this Guide
- Other Documents You May Need
- For Help

## Chapter 2: Installing a SNAP PAC Brain
- What You Will Need
- Installing Hardware
  - Installing Modules on the Rack
  - Removing a Module
  - Installing the Brain
  - Setting Up Ethernet Networking
  - Setting Up Serial Networking
  - Guidelines for Grounding SNAP PAC Brains and Controllers
- Serial Wiring Diagrams
- What's Next?

## Chapter 3: System Architecture
- Communication Options
- SNAP PAC Ethernet Brains (Obsolete)
  - Simultaneous Communication
- SNAP PAC Serial Brains (Obsolete)
- Accessing SNAP PAC Brains Over the Internet
- Choosing Communication Methods
- System Architecture
  - SNAP PAC Brains as Part of a Distributed SNAP PAC System
  - SNAP PAC Ethernet Brain in an Allen-Bradley Logix System
  - SNAP PAC Ethernet Brain as an Independent I/O Processor
  - SNAP PAC Serial Brain as an Independent I/O Processor
Chapter 4: Maintenance and Troubleshooting ........................................ 35

Introduction ............................................................................. 35
Maintaining the SNAP PAC Brain ........................................... 35
Backup Battery ........................................................................ 35
Changing an Ethernet Brain’s IP Address ................................. 36
Resetting a SNAP PAC Brain .................................................. 36
Loading New Firmware ............................................................ 36
Setting Time and Date ............................................................. 36
Blink Codes ............................................................................. 37
  Self-Test LED Sequence at Startup ..................................... 37
  Normal LED Behavior: MS and NS LEDs ......................... 37
  STAT LED—Green ............................................................... 38
  STAT LED—Orange ............................................................ 38
  STAT LED—Red and Green ............................................... 38
  STAT LED—Red ................................................................. 38
Getting Device and Firmware Information ............................... 39
Troubleshooting SNAP PAC Brains ........................................... 41
  Communicating with an EB Brain ...................................... 41
  Pinging the Brain .............................................................. 42
  Accessing the Ethernet Brain with PAC Manager ............... 42
  Solving Ethernet Network Problems ................................... 43
  Communicating with an SB Brain ....................................... 44
  Timeout Errors when Communicating via a Controller ....... 45
  Turning on Communication Error Blink Codes (Serial Brain) 45
Additional Troubleshooting Tools .............................................. 47
  Making Sure the Brain is in Normal Mode ......................... 47
  TCP Settings (Ethernet Brains) ............................................ 47

Appendix A: Serial Cables and Addressing ................................. 49

Serial Cables ........................................................................... 49
Address Table ........................................................................ 49

Index ....................................................................................... 51
1: Introduction

ABOUT SNAP PAC BRAINS

NOTE: Due to the unavailability of essential parts, all SNAP PAC brains (EB-series) are obsolete and no longer available. Instead of Ethernet-based brains, use a SNAP-PAC-R1 controller/brain; it has all the same features plus additional power (and programmability, if you need it). For serial brain options, contact Opto 22 Product Support.

SNAP PAC brains are powerful and versatile I/O and network communications processors for your SNAP PAC System™. These brains are designed primarily to work in distributed systems controlled by a SNAP PAC programmable automation controller. SNAP PAC Ethernet brains can also be used as intelligent remote I/O in a groov EPIC system or an Allen-Bradley® Logix-based PLC system.

All SNAP PAC brains provide local intelligence that frees the controller for supervisory tasks. SNAP PAC brains can also be used independently for standalone I/O processing and communication.

SNAP PAC brains use either Ethernet networks or serial networks.

- The Ethernet Brains—SNAP-PAC-EB1 and SNAP-PAC-EB2—share the same functions and features except that the SNAP-PAC-EB1 provides high-speed digital functions. The SNAP-PAC-EB2 does not offer high-speed digital.

- The two Serial Brains—SNAP-PAC-SB1 and SNAP-PAC-SB2—are like each other in their functions and features except that the SNAP-PAC-SB1 provides high-speed digital functions. The SNAP-PAC-SB2 does not offer high-speed digital.

Because EB brains and SB brains run on different networks, some of their features differ. For a comparison of brain features, see page 29.

I/O Processing

As an I/O processor, the SNAP PAC brain provides the local intelligence to independently handle functions such as latching, counting, thermocouple linearization, watchdog timers, and PID loop control. These functions continue to work on the brain even if communication with the controller is lost.

Each SNAP PAC brain mounts on a SNAP PAC rack with up to 4, 8, 12, or 16 SNAP I/O™ modules. Each module provides from 1 to 32 I/O points, depending on the module.

SNAP PAC Ethernet brains support all SNAP I/O analog, digital, and serial input and output modules available on the Opto 22 website. SNAP PAC Serial brains support all analog and digital SNAP I/O modules (including high-density).

All SNAP I/O modules can be mixed on the same mounting rack and placed in any position on the rack, to accommodate the required mix of signals at any location. For more information on mounting racks, see the SNAP PAC Racks data sheet (form 1684). For more information on I/O modules, visit our website at www.opto22.com.
Communications

In addition to I/O processing, SNAP PAC brains provide communication through a choice of networks:

- **Ethernet**—SNAP-PAC-EB1, SNAP-PAC-EB1-FM [OBSOLETE], SNAP-PAC-EB2, and SNAP-PAC-EB2-FM [OBSOLETE] brains communicate over a standard 10/100 Mbps Ethernet network. Each brain is equipped with two switched Ethernet network interfaces. Because these interfaces share a single IP address and act just like an Ethernet switch, SNAP PAC brains can be installed in a multi-drop (daisy-chain) configuration, extending the control network without the expense of additional Ethernet network hardware. SNAP PAC brains can also be installed in a star configuration using standard, off-the-shelf Ethernet network components.

  **NOTE:** If you replace a SNAP PAC Ethernet brain with a SNAP PAC R-series controller, be aware that the controller has two independent, not switched, Ethernet interfaces. You can install an R-series brain only in a star configuration, not multi-drop. Contact Opto 22 Product Support (page 4) with any networking questions.

- **Serial**—SNAP-PAC-SB1 and SNAP-PAC-SB2 brains communicate over a standard RS-485 network, either two-wire or four-wire, using a binary protocol. Baud rates from 300 to 230,400 bps are supported. There are 256 possible multidrop addresses.

PAC Project Software Suite

SNAP PAC brains are primarily designed for use with a SNAP PAC programmable automation controller or a groov EPIC processor running a control program built with PAC Project™ software. SNAP PAC R-series controllers and groov EPIC processors can communicate with Ethernet brains only; SNAP PAC S-series controllers can communicate with both serial and Ethernet brains at the same time. The controller runs a control program, called a strategy, which you develop using PAC Project™ software.

The PAC Project Software Suite comes in two forms, Basic and Professional:

- **PAC Project Basic™**, which is included in the purchase of a SNAP PAC controller, consists of control programming, human-machine interface (HMI) creation, and configuration software.

- **PAC Project Professional™** is available for purchase and adds OptoOPCServer™ for OPC communications, OptoDataLink™ for database connectivity, and additional features.

For more information about PAC Project, see the PAC Project data sheet (form 1699), available on our website, www.opto22.com.

Other Communication Methods

While most customers use the PAC Project software suite for control, monitoring, and data acquisition, SNAP PAC brains can communicate using other several other methods.

Both SB and EB brains can be used as standalone I/O and communications processors for PC-based I/O. SNAP PAC EB brains can also be used as intelligent remote I/O in an Allen-Bradley® RSLogix® PLC system.

**SNAP PAC Ethernet brains** support communication using multiple protocols running simultaneously over Ethernet. You can communicate with SNAP PAC Ethernet brains using the following tools:

<table>
<thead>
<tr>
<th>For</th>
<th>For details, see</th>
</tr>
</thead>
<tbody>
<tr>
<td>EtherNet/IP</td>
<td>Allen-Bradley systems</td>
</tr>
<tr>
<td></td>
<td><em>EtherNet/IP for SNAP PAC Protocol Guide</em>, form 1770</td>
</tr>
<tr>
<td>Modbus/TCP</td>
<td>Modbus communication</td>
</tr>
<tr>
<td>SNMP</td>
<td>Network management</td>
</tr>
<tr>
<td></td>
<td><em>PAC Manager User’s Guide</em>, form 1704</td>
</tr>
<tr>
<td>FTP</td>
<td>The brain’s built-in file system</td>
</tr>
<tr>
<td></td>
<td><em>PAC Manager User’s Guide</em>, form 1704</td>
</tr>
<tr>
<td>SMTP</td>
<td>Email clients</td>
</tr>
<tr>
<td></td>
<td><em>PAC Manager User’s Guide</em>, form 1704</td>
</tr>
<tr>
<td>OptoMMP</td>
<td>MMP communication</td>
</tr>
<tr>
<td></td>
<td><em>OptoMMP Protocol Guide</em>, form 1465</td>
</tr>
</tbody>
</table>
SNAP PAC serial brains support communication using OptoMMP, Opto 22’s open and documented memory-mapped protocol. For details, see the OptoMMP Protocol Guide (form 1465).

Custom Software

If you are not using PAC Project and want to develop custom software to communicate with the brain, you can quick start your development process with two free Opto 22 software development kits (SDKs), which you can download from our website at www.opto22.com:

- For Visual Basic® and C++®—the PAC-DE V-OPTOMMP-CPLUS software development kit (SDK). The SDK supports Microsoft Windows® and Linux, and includes all documentation.
- For Visual Studio® 2010 through 2017—the PAC-DEV-OPTOMMP-DOTNET SDK for .NET developers. The SDK supports Microsoft’s .NET frameworks 4.0 through 4.5, and includes all documentation.

ABOUT THIS GUIDE

This guide shows you how to install and use SNAP PAC brains. This guide assumes that you are already familiar with networking (serial or Ethernet) for the types of brains you’ll be using. If you are not familiar with these subjects, we strongly suggest you consult commercially available resources to learn about them before attempting to install or use SNAP PAC brains.

The following sections are included in this user’s guide:

**Chapter 1: Introduction**—information about the guide and how to reach Opto 22 Product Support.

**Chapter 2: Installing a SNAP PAC Brain**—quick-start steps to get SNAP PAC brains up and running quickly.

**Chapter 3: System Architecture**—conceptual information on networking and communicating with SNAP PAC brains, and brain specifications.

**Chapter 4: Maintenance and Troubleshooting**—changing IP addresses, resetting the brain to factory defaults, and upgrading firmware; blink codes and other troubleshooting assistance.

**Appendix A: Serial Cables and Addressing**—for SNAP PAC serial brains, shows how to set address switches for all possible brain addresses.

Other Documents You May Need

You’ll find most of the documentation to build and maintain your control system in the PAC Project folder that’s added to your Windows Desktop when you install PAC Project. While using PAC Project applications, online help is available by clicking Help in the menu bar or the Help buttons in dialog boxes, or simply by pressing the F1 key.

Here’s a brief list of documents you may find helpful. You can also download other documents, sample files, software utilities, technical notes, integration kits, and much more from the Opto 22 website.

**Tip:** To easily find documents on our website, search on the form number.
FOR HELP

If you have problems installing or using SNAP PAC brains and cannot find the help you need in this guide or on our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO
(800-835-6786 toll-free in the U.S. and Canada)
951-695-3080
Monday through Friday,
7 a.m. to 5 p.m. Pacific Time

Email: support@opto22.com

Opto 22 website: www.opto22.com

When calling for technical support, you can help us help you faster if you provide the following information to the Product Support engineer:

• A screen capture of the Help > About dialog box showing software product and version (available by clicking Help > About in the application’s menu bar).
• Opto 22 hardware part numbers or models that you’re working with.
• Firmware version:
  – For groov EPIC processors and groov RIO modules: available in groov Manage by clicking Info and Help > About.
  – For SNAP controllers and brains: available in PAC Manager by clicking Tools > Inspect.
• Specific error messages you received.
• Version of your computer’s operating system.
• For PAC Control, PAC Display, OptoOPCServer, or PAC Manager, you may be requested to provide additional information, such as log or dump files. You can find these files in a support files sub-folder:
  a. On your Windows Desktop, double-click the PAC Project 10.4 folder.
  b. Double-click Support Files.
  c. Double-click on the appropriate shortcut to open the sub-folder containing the requested files.

---

<table>
<thead>
<tr>
<th>For this information</th>
<th>See this guide</th>
<th>Form #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Designing flowchart-based control programs for the system (requires a SNAP PAC S-series or R-series industrial controller)</td>
<td>PAC Control User’s Guide</td>
<td>1700</td>
</tr>
<tr>
<td></td>
<td>PAC Control Command Reference</td>
<td>1701</td>
</tr>
<tr>
<td></td>
<td>PAC Control Commands Quick Reference</td>
<td>1703</td>
</tr>
<tr>
<td>Programming your own applications by using either:</td>
<td>OptoMMP Protocol Guide</td>
<td>1465</td>
</tr>
<tr>
<td>• The OptoMMP protocol for memory-mapped controllers and brains</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• One of the OptoMMP Software Development Kits (SDKs)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Communicating with SNAP PAC brains using OPC*</td>
<td>OptoOPCServer User’s Guide</td>
<td>1439</td>
</tr>
<tr>
<td>Connecting the SNAP PAC System with databases</td>
<td>OptoDataLink User’s Guide</td>
<td>1705</td>
</tr>
<tr>
<td>Communicating with I/O units using Modbus/TCP</td>
<td>Modbus/TCP Protocol Guide</td>
<td>1678</td>
</tr>
<tr>
<td>Communicating with I/O units using EtherNet/IP</td>
<td>EtherNet/IP for SNAP PAC Protocol Guide</td>
<td>1770</td>
</tr>
</tbody>
</table>

* OptoOPCServer communication with SNAP PAC serial brains requires a SNAP PAC controller.
**Note:** PAC Control, PAC Display, OptoOPCServer, and PAC Manager create appropriate sub-folders when they create diagnostic log or dump files. If they have not created these files, the sub-folder may not exist; in this case, the shortcut will not work.
2: Installing a SNAP PAC Brain

If you already know how you will use the SNAP PAC brain and want to get it running quickly, follow the sections in this chapter.

To learn about communication options and networking, start on page 17. Specifications are listed on page 28.

WHAT YOU WILL NEED

You’ll need the following items to install a SNAP PAC brain:

- A PC running Microsoft® Windows® 10 Professional (32-bit or 64-bit) or Windows 11
- **For an Ethernet connection**, the PC also needs a 10/100 MB Ethernet adapter card, the TCP/IP protocol installed, and a valid IP address, on the same subnet as the brain. (For more information, see “Ethernet Networking (Ethernet Brains Only)” on page 25.) In addition, you need a standard Ethernet cable for direct connection to the PC (recommended), or an available connection to a standard 10BASE-T or 100BASE-TX Ethernet network.
- **For a serial connection**, RS-485 (2-wire or 4-wire) connection to a SNAP PAC S-series controller or to a PC with an Opto 22 PCI-AC48 adapter card. (See “Setting Up Serial Networking” on page 10 for more information and wiring diagrams.)
- SNAP PAC brain (See page 29 for a chart comparing models.)
- SNAP PAC mounting rack and SNAP I/O modules chosen for your application.
- A SNAP-PS5 or SNAP-PS5U power supply or other 5 VDC power supply (-0/+0.1 VDC at 4.0 A) applied to the rack. (Additional power may be required for SNAP I/O modules depending on the number and type of modules used. See the module data sheets on our website, www.opto22.com, for information.)

INSTALLING HARDWARE

Assemble the rack and power supply according to the directions that came with them.

**Installing Modules on the Rack**

Modules snap into place in the row of connectors on the rack. Each module connector has a number. Ethernet-based brains support all SNAP I/O modules. Serial-based brains support all SNAP I/O analog and digital modules (including high-density modules).

*NOTE: Any type of module can be placed in any position on the rack. Check module data sheets for power requirements and any quantity limitations. See the chart on page 29 for brain compatibility.*

1. Place the rack so that the module connector numbers are right-side up, with zero on the left.
2. Position the module over the module connector, aligning the small slot at the base of the module with the retention bar on the rack.

3. With the module correctly aligned over the connector, push on the module to snap it into place.

When positioning modules next to each other, be sure to align the male and female module keys (shown in the detailed view in the illustration at right) before snapping a module into position.

Modules snap securely into place and require a special tool (provided) for removal. To remove a module, see page 9.

4. (Optional) Use standard 4-40 x 1/2 truss-head Phillips hold-down screws to secure both sides of each module.

CAUTION: Do not over-tighten screws.

5. Plug the wiring connector into each module to attach modules to the devices they monitor.

Wiring diagrams are in the module’s data sheet.
CHAPTER 2: INSTALLING A SNAP PAC BRAIN

Removing a Module

If you need to remove a module, follow these steps.

1. If the modules are held in place with screws, remove them.
2. Holding the SNAP module tool (provided) as shown in the illustration at right, insert it into the notch at the base of the module.
3. Squeeze the module tool against the module to open the release latch, and pull straight up on the module to remove it.

Installing the Brain

1. Remove the brain from its packaging.
2. Turn off power to the rack assembly.
3. Align the brain connector with the mating connector on the mounting rack.
4. Seat the brain onto the connector and use the hold-down screw to secure the brain in position. Do not overtighten.
5. To attach network cabling and configure addressing, skip to one of the following:

Setting Up Ethernet Networking

1. For an Ethernet brain (obsolete), use Category 5 or superior solid unshielded twisted-pair cable to connect the brain in one of the following ways:
   – (Recommended for initial configuration) Connect to a PC directly, using a standard Ethernet cable.
   – Connect to a standard 10BASE-T or 100BASE-TX Ethernet network that has a PC on the same subnet as the brain and does NOT have a Dynamic Host Configuration Protocol (DHCP) server.
   Maximum cable or segment length is 100 meters; minimum cable length is one meter.

   NOTE: When connecting the controller to a managed switch, make sure the managed switch’s port configuration is set to Auto for the Duplex setting and Auto for the Speed setting.

2. Before turning on power to the rack, follow instructions in the PAC Manager User’s Guide (form 1704) to assign an IP address to the brain. Exception: If you are using the brain with an Allen-Bradley Logix® system, follow instructions in the EtherNet/IP for SNAP PAC Protocol Guide (form 1770).
Setting Up Serial Networking

The serial brain can be connected to a SNAP PAC S-series controller or to a PC equipped with an Opto 22 PCI-AC48 adapter card, which provides an RS-485 serial converter.

If you are using PAC Control software, connect the brain to an S-series controller.

Follow the diagram at right and the steps below to set up serial networking.

1. Attach an RS-485 serial cable to the serial port. (See Appendix A: Serial Cables and Addressing for cable recommendations).
2. Follow the wiring diagrams beginning on page 12 for the serial network.
3. Rotate the baud rate switch to set the desired baud rate, as follows:

<table>
<thead>
<tr>
<th>Baud rate</th>
<th>Switch position</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Reserved)</td>
<td>F</td>
</tr>
<tr>
<td>230400 bps</td>
<td>E</td>
</tr>
<tr>
<td>115200 bps</td>
<td>D</td>
</tr>
<tr>
<td>76800 bps</td>
<td>C</td>
</tr>
<tr>
<td>57600 bps</td>
<td>B</td>
</tr>
<tr>
<td>38400 bps</td>
<td>A</td>
</tr>
<tr>
<td>19200 bps</td>
<td>9</td>
</tr>
<tr>
<td>9600 bps</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Baud rate</th>
<th>Switch position</th>
</tr>
</thead>
<tbody>
<tr>
<td>4800 bps</td>
<td>7</td>
</tr>
<tr>
<td>2400 bps</td>
<td>6</td>
</tr>
<tr>
<td>1200 bps</td>
<td>5</td>
</tr>
<tr>
<td>600 bps</td>
<td>4</td>
</tr>
<tr>
<td>300 bps</td>
<td>3</td>
</tr>
<tr>
<td>(Reserved)</td>
<td>2</td>
</tr>
<tr>
<td>(Reserved)</td>
<td>1</td>
</tr>
<tr>
<td>(Reserved)</td>
<td>0</td>
</tr>
</tbody>
</table>

4. Set termination and biasing:

Termination: RS-485 Termination should be applied at the first device (typically a SNAP PAC S-series controller or PCI-AC48) and at the last SB brain on the RS-485 communication link. For proper termination settings, see the wiring diagrams starting on page 12.

Biasing: Biasing should be applied at one location on the RS-485 communication link. Each SB brain has a very small amount of fixed bias. Be sure to apply biasing at the host device, which is typically a SNAP PAC S-series controller or a PCI-AC48.

NOTE: Bias on a SNAP PAC SB brain is always ON.

5. Use the two rotary address switches to set the unit’s address.

There are 256 possible addresses, 0–255. See Appendix A: Serial Cables and Addressing for a table of addresses and how to set them using the two 16-position rotary address switches.
Guidelines for Grounding SNAP PAC Brains and Controllers

**Power supply side**: The DC output of the power supply to the I/O unit (or controller) should be “floating,” which means the negative output terminal is not tied to ground.

**RS-485 serial cable side**: Connect the signal common from the controller to the signal common on each of the I/O units using an insulated wire that is part of the serial cable. Though sometimes hard to find, there are cables that have a twisted pair for serial communication plus an additional insulated wire for common. However, it might be easier to obtain a cable that has an extra twisted pair and then use one of the wires from this extra pair for the signal common connections.

NOTE: Make sure there are enough wires in the cable for a separate insulated signal common wire. Do not connect the signal common wire to chassis ground. Do not use the overall cable shield drain wire as the signal common.

Connect the cable shield drain wire to chassis ground at one location only. If the shield is not continuous from one I/O unit to the next, then the shield of each segment will need to be tied to chassis ground at one location only per segment.
Serial Wiring Diagrams

Wiring a SNAP PAC SB-Series Brain to a SNAP-PAC-S1 Controller

Two-wire

- TX/RX +
- TX/RX –
- COM

- Chassis GND

- Pin 1

- Switches 3 & 2 OFF
- Switch 1 ON

- 2-wire, middle of link
- All switches OFF

- 2-wire termination, end of link
- Switches 3 & 2 OFF
- Switch 1 ON
Wiring a SNAP PAC SB-Series Brain to a SNAP-PAC-S2 Controller

**Two-wire**

1. Pin 1
2. TX/RX +
3. TX/RX –
4. COM

**Four-wire**

1. RX +
2. RX –
3. COM
4. TX/RX +
5. TX/RX –

**NOTE:** The connector pins on an actual SNAP-PAC-S2 are in a different order than shown here.
Wiring to a PCI-AC48 Adapter Card in a PC

NOTE: Check the default termination and bias on the PCI-AC48 and make certain they are set appropriately for the network.

Two-wire

PCI-AC48 adapter card in PC

Chassis GND

Pin 1

TX/RX +
TX/RX –
COM

2-wire termination, end of link
Switches 3 & 2 OFF
Switch 1 ON

2-wire, middle of link
All switches OFF

Four-wire

PCI-AC48 adapter card in PC

Chassis GND

Pin 1

TX/RX +
TX/RX –
COM
RX +
RX –

4-wire termination, end of link
Switch 3 OFF
Switches 2 & 1 ON

4-wire, middle of link
All switches OFF
WHAT'S NEXT?

To start configuring I/O points, see one of the following:

- If you are using PAC Control software, follow instructions in the PAC Control User’s Guide (form 1700).
- If you are using the brain in an A-B RSLogix system, follow configuration steps in the EtherNet/IP for SNAP PAC Protocol Guide (form 1770).
- If you are not using PAC Control or RSLogix, follow instructions in the PAC Manager User’s Guide (form 1704). To learn more about SNAP PAC brain capabilities and network options, see Chapter 3: System Architecture. If you are planning to install multiple Ethernet brains in a daisy-chain configuration, see “Using SNAP PAC Ethernet Brain Network Interfaces” on page 26.

To use OLE for process control (OPC) with SNAP PAC brains, purchase OptoOPCServer and see the OptoOPCServer User’s Guide (form 1439, available with purchase of OptoOPCServer).

To communicate with SNAP PAC brains using Modbus/TCP, see the Modbus/TCP Protocol Guide (form 1678).

To program your own applications to communicate with the SNAP PAC brain, see the OptoMMX Protocol Guide (form 1465)
This chapter explains how to use SNAP PAC brains on an Ethernet or serial network and how to communicate with them. It includes information on:

- **Communication options**
- **System architecture**
- **Networking**
- **Specifications and feature comparison charts**

### COMMUNICATION OPTIONS

SNAP PAC brains communicate over Ethernet or serial.

- **SNAP PAC EB** brains (obsolete) communicate over an Ethernet network (all part numbers containing EB). See the following section for more information.
- **SNAP PAC SB** brains communicate over a serial network (part numbers SNAP-PAC-SB1 and SNAP-PAC-SB2). See page 18.

### SNAP PAC Ethernet Brains (Obsolete)

SNAP PAC Ethernet-based brains communicate using TCP/IP or UDP/IP over a wired or wireless network.

- **Physical Layer**—SNAP PAC EB brains communicate over a 10- or 100-Mbps wired Ethernet link.
- **Transport Layer**—The key to the SNAP PAC brain’s communication flexibility is the transport layer, Internet Protocol (IP). Both the Transmission Control Protocol (TCP) and the User Datagram Protocol (UDP) are used with IP.
- **Application Layer**—Because SNAP PAC brains use standard IP for the transport layer, many communication options are possible in the application layer. After the I/O unit is installed and has an IP address assigned (see page 9), you can communicate with it using the following methods:
  - **PAC Control** strategies running on a SNAP PAC controller or a groov EPIC processor can configure, read, and write to I/O points on SNAP PAC brains.
  - **PAC Manager** software, in addition to its use for assigning IP addresses, can also be used to configure I/O points and features, and to perform onetime reads and writes.
  - **EtherNet/IP** provides communication with Allen-Bradley ControlLogix® and CompactLogix™ PLC systems and other systems using the EtherNet/IP protocol. Both implicit and explicit messaging are supported.
COMMUNICATION OPTIONS

- **Modbus/TCP** provides a direct connection with Modbus/TCP hardware or software or third-party software applications, which can read or write to I/O points on SNAP PAC brains.
- **OPC** (OLE for Process Control) uses OptoOPCServer to serve data to any OPC 2.0-compliant application, such as an HMI, which can also read or write to I/O points. OptoOPCServer can be purchased separately or as part of the PAC Project Professional software suite.
- **OptoDataLink** exchanges I/O point data with ODBC-compliant databases, including Microsoft® SQL Server®, Microsoft Access®, MySQL®, and others. OptoDataLink can be purchased separately or as part of PAC Project Professional.
- **SMTP** (Simple Mail Transfer Protocol) connects a SNAP PAC brain with corporate email servers, so employees can be emailed or paged if there’s a problem on devices attached to the brain.
- **SNMP** (Simple Network Management Protocol) makes it possible to monitor devices attached to SNAP PAC brains just as you would any computer or server on the Ethernet network, using an SNMP-based enterprise management system such as Computer Associates’ Unicenter®, Hewlett-Packard’s OpenView®, or IBM’s Tivoli®. When a monitored event occurs, such as a door left open or a pressure level too high, the brain sends an SNMP trap to the management system (compatible with SNMP v2.0c using brain firmware R8.2a or higher).
- **FTP** (File Transfer Protocol) can be used to transfer files and data to and from the SNAP PAC brain, whether to custom applications, enterprise databases, or any file system.
- **Custom software applications** are easy to develop using our free OptoMMP software development kits (SDKs). They use the OptoMMP protocol, an IEEE 1394-based protocol, to read and write to SNAP PAC brains.
  - For Visual Basic® and C++—the PAC-DEV-OPTOMMP-CPLUS software development kit (SDK). The SDK supports Microsoft Windows® and Linux, and includes all documentation.
  - For Visual Studio® 2010 through 2017—the PAC-DEV-OPTOMMP-DOTNET SDK for .NET developers. The SDK supports Microsoft’s .NET frameworks 4.0 through 4.5, and includes all documentation.

Simultaneous Communication

The SNAP PAC Ethernet brain can communicate *simultaneously* using all of the methods listed above. The reason lies in the nature of IP.

In serial communication, a single data request is sent by one device to another. The first device must wait for a response before any additional communication can be carried out. IP, however, can establish multiple simultaneous sessions, so many data requests can be sent at once without waiting for any individual response. Each request gets a response, but the link isn’t idle while waiting for responses.

In addition, IP can simultaneously handle multiple requests from multiple devices. A PC can communicate with all SNAP PAC brains and controllers on the same network—all at the same time—and multiple PCs can communicate with one SNAP PAC device at the same time.

So, for example, a SNAP PAC brain can respond to directions from a Modbus master, give analog point data to a technician using PAC Manager, and carry out instructions from a custom C++ application—all at once.

SNAP PAC Serial Brains (Obsolete)

SNAP PAC serial brains use an RS-485 link, either 2-wire or 4-wire. Communication can be through any SNAP PAC S-series controller (via an Ethernet connection to the controller and then a serial connection from the controller to the brain) or directly from a PC to the brain (using the computer’s serial port via a serial cable and an RS-485 adapter, such as an Opto 22 PCI-AC48 adapter card). More information on wiring begins on page 10.

---

1 For information about data transfer speed when using a controller to communicate with a serial brain, see page 45.
Communication methods include:

- **PAC Control** strategies running on a SNAP PAC controller can configure, read, and write to I/O points on SNAP PAC brains.
- **PAC Manager** software can be used to configure I/O points and features; in addition it can be used to perform onetime reads and writes.
- **Custom software applications** can be developed using the OptoMMP protocol to read and write to SNAP PAC brains. For Ethernet brains, use our OptoMMP SDKs. For serial brains, the Toolkit cannot be used, but you can build your own driver for the protocol.

**OPC clients** and **SQL databases** can exchange data with SNAP PAC serial brains through the SNAP PAC controller. You can use OptoOPCServer for communication with any OPC 2.0-compliant application, such as an HMI. Use OptoDataLink for connectivity with ODBC-compliant databases, including Microsoft SQL Server, Microsoft Access, and MySQL. OptoOPCServer and OptoDataLink can be purchased separately or as part of PAC Project Professional.

Communication routes are summarized in the following table.

<table>
<thead>
<tr>
<th>For this purpose</th>
<th>Use this software</th>
<th>Communication route</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Direct (serial)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>From controller</td>
</tr>
<tr>
<td>Configuration, control, monitoring, and data acquisition</td>
<td>PAC Control</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Custom software</td>
<td>●</td>
</tr>
<tr>
<td>Configuration and one-time reads/writes for testing or troubleshooting</td>
<td>PAC Manager</td>
<td>●</td>
</tr>
<tr>
<td>OPC communication</td>
<td>OptoOPCServer</td>
<td>●</td>
</tr>
<tr>
<td>SQL database connectivity</td>
<td>OptoDataLink</td>
<td>●</td>
</tr>
</tbody>
</table>

**Accessing SNAP PAC Brains Over the Internet**

Since **SNAP PAC Ethernet brains** are just like any other hardware on the Ethernet network, you can access them over the Internet in exactly the same way you would access a computer. The details depend on your network and Internet connection. Consult your system or network administrator or your Internet Service Provider (ISP) for more information.

**SNAP PAC serial brains** cannot be directly accessed over the Internet; communication must go through the SNAP PAC controller or through a PC with a PCI-AC48 adapter card.
## Choosing Communication Methods

How do you need to communicate with SNAP PAC brains to match the tasks your application requires? Check the following table for help in choosing communication methods and finding out where to look for more information on them.

<table>
<thead>
<tr>
<th>This task</th>
<th>Can be done using these methods</th>
<th>Comments and references</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure I/O units.</td>
<td>PAC Control, EtherNet/IP Configurator, or PAC Manager</td>
<td>Recommended: OptoMMP SDKs or OptoMMP protocol. Alternate: PAC Manager. If you are using PAC Control, configure the system in PAC Control. See the <strong>PAC Control User’s Guide</strong> (form 1700). If communicating with an A-B Logix system, use EtherNet/IP Configurator. See the <strong>EtherNet/IP for SNAP PAC Protocol Guide</strong> (form 1770). For the Communication Toolkit or OptoMMP protocol, see the <strong>OptoMMP Protocol Guide</strong> (form 1465).</td>
</tr>
<tr>
<td>Monitor and control processes; acquire data.</td>
<td>PAC Control flow-chart logic</td>
<td>Recommended: PAC Manager Inspect window or OptoMMP SDKs or OptoMMP protocol. Alternate: EtherNet/IP Configurator. For more information see the <strong>PAC Control User’s Guide</strong> (form 1700) and the <strong>PAC Control Command Reference</strong> (form 1701). <strong>CAUTION:</strong> Events and reactions set up using alternate methods are faster than flowchart logic, but be careful if you use them. They can conflict with PAC Control logic, because both write to the brain’s memory map. For Communication Toolkit or OptoMMP protocol, see the <strong>OptoMMP Protocol Guide</strong> (form 1465).</td>
</tr>
<tr>
<td>Give technicians an HMI with alarming and trending.</td>
<td>PAC Display</td>
<td>Recommended: PAC Display. Alternate: Ethernet-based brains only. See the <strong>PAC Display User’s Guide</strong> (form 1702).</td>
</tr>
<tr>
<td>Communicate with Allen-Bradley Logix PLC systems</td>
<td>EtherNet/IP</td>
<td>Recommended: EtherNet/IP. Alternate: Ethernet-based brains only; For details, see the <strong>Modbus/TCP Protocol Guide</strong> (form 1678).</td>
</tr>
<tr>
<td>Communicate with Modbus/TCP hardware or software.</td>
<td>Modbus/TCP</td>
<td>Recommended: Modbus/TCP. Alternate: Ethernet-based brains only; For details, see the <strong>EtherNet/IP for SNAP PAC Protocol Guide</strong> (form 1770).</td>
</tr>
<tr>
<td>Exchange I/O point data with third-party software such as HMIs and databases.</td>
<td>OptoOPCServer for OPC; OptoDataLink for databases</td>
<td>Recommended: OptoOPCServer for OPC; OptoDataLink for databases. Alternate: groov EPIC processor software (EB brains only). Purchase OptoOPCServer or OptoDataLink separately or as part of PAC Project Professional. <strong>NOTE:</strong> EB brains can communicate directly with OptoOPCServer and OptoDataLink. SB brains must communicate through a PAC Control strategy running on an S-series controller. See the <strong>OptoOPCServer User’s Guide</strong> (form 1439). The <strong>OptoDataLink User’s Guide</strong> (form 1705) is available with purchase of OptoDataLink.</td>
</tr>
<tr>
<td>Send email or page someone. Send SNMP trap. Monitor devices through an enterprise management system.</td>
<td>PAC Control (and PAC Manager for configuration)</td>
<td>Recommended: PAC Control (and PAC Manager for configuration). Alternate: OptoMMP SDKs or OptoMMP protocol. Purchase OptoOPCServer or OptoDataLink separately or as part of PAC Project Professional. See the <strong>PAC Manager User’s Guide</strong> (form 1704). For Communication Toolkit or OptoMMP, see the <strong>OptoMMP Protocol Guide</strong> (form 1465).</td>
</tr>
<tr>
<td>Write your own software application to communicate with the system.</td>
<td>C++ and .NET: OptoMMP SDKs and brain’s memory map; Opto 22’s OptoMMP protocol and brain’s memory map.</td>
<td>Recommended: C++ and .NET: OptoMMP SDKs and brain’s memory map. Alternate: Opto 22’s OptoMMP protocol and brain’s memory map. See the <strong>OptoMMP Protocol Guide</strong> (form 1465).</td>
</tr>
</tbody>
</table>
SNAP PAC brains can be used in the following ways:

- For distributed intelligence in a larger control system based on a SNAP PAC controller or groov EPIC processor running PAC Control, or an Allen-Bradley PLC running an RSLogix program
- As an independent I/O processor

The following diagrams illustrate these uses.

**SNAP PAC Brains as Part of a Distributed SNAP PAC System**

The following diagram shows only basic SNAP PAC System capabilities using free PAC Project Basic software. For information on additional capabilities, such as communication with OPC clients, databases, and third-party systems, see the *SNAP PAC System Specification Guide* (form 1696).

PC used to develop a PAC Control strategy. Once developed, the strategy runs independently on the SNAP PAC controller. SNAP PAC brains and I/O (distributed units). The top four are on an Ethernet network; the bottom two are on a serial network.
SNAP PAC Ethernet Brain in an Allen-Bradley Logix System

SNAP PAC Ethernet brains can be used as intelligent remote I/O in an A-B Logix system, such as ControlLogix (shown below) or CompactLogix. The brain is more than a bus coupler but does not require programming. Instead, multiple I/O functions are built in.

Because the brain automatically handles many processing tasks locally, you can add more I/O points and process control functions to your system with little impact on PLC scan time. The system as a whole becomes more efficient with intelligence distributed to the remote I/O.
SNAP PAC Ethernet Brain as an Independent I/O Processor

As the following diagram illustrates, you can communicate with an independent SNAP PAC Ethernet brain using Modbus/TCP, the OptoOPCServer (available separately), SNMP, SMTP, or applications you develop using the free OptoMMP SDKs or our OptoMMP protocol.
SNAP PAC Serial Brain as an Independent I/O Processor

As the following diagram shows, you can communicate with an independent SNAP PAC serial brain using a PC with an Opto 22 PCI-AC48 adapter card. Note that you need to write your own driver for the OptoMMP protocol in order to develop custom software. The OptoMMP SDKs cannot be used with serial brains; it handles Ethernet communication only.

See “Setting Up Serial Networking” on page 10 for more information on wiring to the PC.
ETHERNET NETWORKING (ETHERNET BRAINS ONLY)

From a physical standpoint, obsolete SNAP PAC Ethernet brains can be networked in several ways:

- Connected directly to a PC or controller using a standard Ethernet cable
- Attached to an existing TCP/IP Ethernet network
- As part of an independent network built with standard Ethernet hardware

The networking method you use depends on several things, including whether you need control or data acquisition, the number of PCs and I/O units you are using, the speed and volume of communication, security requirements, and the availability of an Ethernet network.

As an option in any network, you can install multiple brains in a daisy-chain configuration. See page 26 for more information.

Connecting Directly to a PC or Controller

A direct connection using a standard Ethernet cable connects the SNAP PAC brain with one host, either a PC or a controller. (The Ethernet interfaces on the EB support Auto MDI-X, which means a crossover cable is not needed for direct connection to a PC.) You can use either Ethernet interface on the brain for the connection. Additional SNAP PAC brains can be daisy-chained from the first brain using the brain’s second Ethernet network interface, which acts as a network switch. See “Using SNAP PAC Ethernet Brain Network Interfaces” on page 26 for more information.

If you need only a small control or monitoring network and have no existing Ethernet network, a direct connection is ideal. It’s quick, easy, and inexpensive because it requires only cables (no separate Ethernet switches or routers). It also provides high speed and high security for a small system.

A direct connection is also useful for assigning an IP address, configuring I/O points, and testing applications. The direct connection eliminates other variables that could interfere with communication, so you can focus on maintenance and troubleshooting.

Attaching to an Existing Ethernet Network

The first rule in attaching SNAP PAC Ethernet brains to an existing network is to work closely with your system administrator, who must determine network topology and hardware. Be sure to consider the impact on your existing network of adding the brains. For best performance, use a 100 Mbps network.

In addition, make sure the system administrator understands that each brain must have a fixed (static) IP address, whether or not a Dynamic Host Configuration Protocol (DHCP) server is used on the network. For more information on IP addresses, see the PAC Manager User’s Guide or the EtherNet/IP for SNAP PAC Protocol Guide.

Because the SNAP PAC brain has two switched Ethernet interfaces, the brains can optionally be daisy-chained together. (See “Using SNAP PAC Ethernet Brain Network Interfaces” on page 26.)

If you need to isolate the control system data from the main network backbone, you can use a router, network switch, or other gateway device. You can also use a SNAP PAC controller, which has two independent Ethernet network interfaces: one interface can be connected to the enterprise network, and the other used for the control system. For more information on network options, see the SNAP PAC System Specification Guide (form 1696).

Developing an Independent Ethernet Network

The third way SNAP PAC Ethernet brains can be used is by developing an independent network. An independent network gives a high level of communication speed and volume, as well as higher security. You
may also need a separate network for critical control applications. Again, the choice depends on your requirements for data transactions, data security, and whether a near-deterministic system is necessary.

If you are building your own network, remember that each brain must have a fixed IP address. See the PAC Manager User’s Guide for more information on IP addresses.

If you have no existing Ethernet network, you can use off-the-shelf Ethernet components to build one. Since Ethernet and TCP/IP are worldwide standards, there are a number of commercially available resources for learning about building and maintaining such a network. We strongly suggest you learn as much as possible about the subject and plan your network carefully before beginning, in order to get the best performance from your system.

Because SNAP PAC brains have two switched Ethernet network interfaces, you can install them in a daisy-chain configuration. See the next section for more information.

**Using SNAP PAC Ethernet Brain Network Interfaces**

As illustrated conceptually at right, SNAP PAC Ethernet brains have two network interfaces. Ethernet 1 and Ethernet 2 are not redundant interfaces; they are connected by an unmanaged switch.

Ethernet devices are normally networked in a standard star configuration. If you are using this standard configuration, connect either Ethernet 1 or Ethernet 2 to the network. The two interfaces share the same IP address, and either one will send a BootP request.

As an option, however, the SNAP PAC brain’s two switched Ethernet interfaces let you use a daisy-chain configuration for distributed I/O, connecting just one brain to the network and then connecting subsequent brains in a chain.

**NOTE:** If you replace a SNAP PAC Ethernet brain with a SNAP PAC R-series controller, be aware that the controller has two independent, not switched, Ethernet interfaces. You can install an R-series brain only in a star configuration, not daisy chained. Contact Opto 22 Product Support (page 4) with any networking questions.

The primary advantage of daisy-chaining is that you save the expense of network routers or switches. The primary disadvantage is similar to that of a serial network: if communication with one brain is lost, communication to all brains beyond it on the daisy chain will also be lost.

Note that if you are updating firmware on the brain, you must update each brain in the daisy chain separately.

**IMPORTANT:** If you choose a daisy-chain configuration, make certain that the brains are connected correctly. Incorrect connections can produce major problems on the network. Make sure that daisy-chain connections are made in a simple open-ended chain, as shown in the diagram on the following page.
Never connect SNAP PAC Ethernet brains in a loop or ring. For example, do not connect both ends of the chain to the same switch, nor to different switches on the same network. As a rule, do not connect the second Ethernet interface on the last brain in the chain to any other device.

NOTE: There is one exception to this rule: you can connect the network in a loop if at least one switch in the loop supports STP/RSTP (Spanning Tree Protocol/Rapid Spanning Tree Protocol) and has that feature enabled.

Correct Connections for Daisy-Chaining

Connection from network, controller, or PC to brain

Daisy-chain connections

Leave the 2nd interface on the last brain unconnected.

NOTE: Connection from a PC does not require a crossover cable. Use a standard Ethernet cable.

Incorrect Network Connections
SPECIFICATIONS

### Serial and Ethernet Brains (Obsolete)

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Requirements</strong></td>
<td>5.0–5.2 VDC at 750 mA maximum (does not include module power requirements)</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>16 MB RAM</td>
</tr>
<tr>
<td><strong>Backup battery for real-time clock</strong></td>
<td>Rechargeable (recharges whenever the brain has power). 5-year life when power is off (replacement part number: SNAP-PAC-BATTERY-ML2430). (Models manufactured before August 2007 have a 3-volt CR2032 lithium battery, available in retail stores. See original user guide for replacement steps.)</td>
</tr>
<tr>
<td><strong>Hold-down screw</strong></td>
<td>Torque: 8 in-lb (0.9 N-m)</td>
</tr>
<tr>
<td><strong>Operating Temperature</strong></td>
<td>-20 to 60 °C</td>
</tr>
<tr>
<td><strong>Storage Temperature</strong></td>
<td>-40 to 85 °C</td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td>0–95% humidity, non-condensing</td>
</tr>
<tr>
<td><strong>Agency approvals and certifications</strong></td>
<td>-EB models: UL, CE, RoHS, DFARS; UKCA</td>
</tr>
<tr>
<td></td>
<td>-SB models: CE, RoHS, DFARS; UKCA</td>
</tr>
<tr>
<td><strong>Warranty</strong></td>
<td>30 months from date of manufacture</td>
</tr>
</tbody>
</table>

### Ethernet Brains (EB) only (Obsolete)

- **Ethernet Network Interfaces**: IEEE 802.3 network, 10Base-T and 100Base-TX. Supports Auto MDI-X (crossover cable not needed). Two switched interfaces, allowing multi-drop (daisy-chain) or standard star network configuration.
- **Maximum Ethernet Segment Length**: 100 meters with Category 5 or superior UTP. For 100 Mbps at this distance, use Category 5 or superior solid UTP.

### Serial Brains (SB) only (Obsolete)

- **Network interfaces**: RS-485, 2- or 4-wire, twisted pair(s), with shield
- **Serial data rates**: 300 baud to 230.4 Kbaud
- **Range: Serial multidrop**: 32 stations maximum on a segment (including PC, controller, repeaters, and I/O units); up to 3000 ft (914 m) on a segment
- **Connector screw**: Torque: 1.7 in-lb (0.19 N-m)

### LEDs and Network Interfaces—Ethernet Brains (Obsolete)

- **Switched Ethernet network interfaces**: Brains can be networked in a daisy-chain configuration or in a standard star configuration using either Ethernet interface. Both interfaces use the same IP address. **NOTE**: When using a daisy-chain configuration, be aware that if power to a brain is lost, all brains beyond it on the network will also lose communication. Firmware on daisy-chained brains must be updated one at a time.

### LEDs

<table>
<thead>
<tr>
<th>LED</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>LNK</td>
<td>Link established with Ethernet network</td>
</tr>
<tr>
<td>ACT</td>
<td>Activity on Ethernet network</td>
</tr>
<tr>
<td>STAT</td>
<td>Brain status</td>
</tr>
<tr>
<td>MS</td>
<td>EtherNet/IP Module Status</td>
</tr>
<tr>
<td>NS</td>
<td>EtherNet/IP Network Status</td>
</tr>
<tr>
<td>Unnamed</td>
<td>Reserved for future use</td>
</tr>
</tbody>
</table>
LEDs and Network Interfaces—Serial Brains (Obsolete)

<table>
<thead>
<tr>
<th>LED</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| SERIAL | Green = Transmit  
Red = Receive  
Amber = Transmit/Receive |
| STAT | Brain status |
| IRQ | Reserved for future use |

Serial port
On a serial brain, the port is RS-485, either 2-wire or 4-wire. Baud rate, termination, and address are set using the switches on the brain’s top cover. See termination and biasing instructions on page 10.

NOTE: IRQ connections and LED are reserved for future use.

See Appendix A: Serial Cables and Addressing for serial cable recommendations. See “Setting Up Serial Networking” on page 10 for wiring. For details on LEDs, see “Blink Codes” on page 37.

SNAP PAC BRAIN COMPARISON CHART

For feature descriptions, see page 31. This table compares SNAP PAC brains with firmware R8.5 or newer. All SNAP PAC brains are obsolete.

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>SNAP-PAC-EB1</th>
<th>SNAP-PAC-EB1-FM*</th>
<th>SNAP-PAC-EB2</th>
<th>SNAP-PAC-EB2-FM*</th>
<th>SNAP-PAC-SB1</th>
<th>SNAP-PAC-SB2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial networking (RS-485, 2-wire or 4-wire)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet networking with two switched Ethernet network interfaces (one IP address)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ethernet network security (IP filtering, port access)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Digital I/O point features</td>
<td>On/off status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Input latching</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Watchdog timer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>High-speed counting (up to 20 kHz)$^2$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Quadrature counting$^3$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On-pulse and off-pulse measurement$^2, 4$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Frequency and Period measurement$^4$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>TPO (time-proportional output)$^4$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Digital totalizing$^4$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pulse generation (N pulses, continuous square wave, on-pulse, and off-pulse)$^4$</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FEATURE</td>
<td>SNAP-PAC-EB1</td>
<td>SNAP-PAC-EB1-FM*</td>
<td>SNAP-PAC-EB2</td>
<td>SNAP-PAC-EB2-FM*</td>
<td>SNAP-PAC-SB1</td>
<td>SNAP-PAC-SB2</td>
</tr>
<tr>
<td>----------</td>
<td>--------------</td>
<td>----------------</td>
<td>-------------</td>
<td>----------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Analog I/O point features</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermocouple linearization (32-bit floating point for linearized values)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Minimum/maximum values</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Offset and gain</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scaling</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Time-proportional output⁵</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Output clamping</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Filter weight</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Watchdog timer</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Analog totalizing⁴</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Ramping⁴</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>I/O modules supported</td>
<td>Digital (4–32 channels per module)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Analog (2–32 channels per module)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial (RS-232, RS-485, motion control, Profibus®, Wiegand®)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Maximum number of modules allowed per I/O unit (with largest rack): Any mix of 16 digital, 16 analog, 8 serial or special-purpose</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>1¹</td>
<td>1¹</td>
</tr>
<tr>
<td>PID logic on the brain (96 PID loops per brain)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Scratch Pad area for peer-to-peer data (bits, floats, integers, strings)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Realtime clock (RTC)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>OPC driver support</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>OptoMMP memory-mapped protocol</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>EtherNet/IP™ (Allen-Bradley® Logix systems and others)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Modbus®/TCP (slave; maximum two Modbus Master connections)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>SNMP (network management)⁷</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>FTP server, file system</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Email (SMTP client)</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>UDP Streaming</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Digital events, Alarm events, Serial events</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Event messaging</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Data logging in the brain</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

¹ OBSOLETE product, please contact Pre-Sales Engineering for more information.
² Does not support serial, motion control, Profibus, or Wiegand modules.
³ Four-channel digital modules only; not available on high-density digital modules.
⁴ Requires a SNAP quadrature input module (SNAP-IDC5Q).
⁵ Available when used with PAC Control Pro R8.2 (or higher) or PAC Control Basic R9.0 (or higher) and a SNAP PAC controller; or when used as remote intelligent I/O with a groov EPIC processor or an Allen-Bradley® PLC system.
⁶ Requires a SNAP analog TPO module (SNAP-AOD-29).
⁷ Currently available on all types of modules except analog modules with more than 4 points.
⁸ Available when used with OptoOPCServer and PAC Control, through a SNAP PAC S-series controller.
⁹ Does not support serial events.
### Feature Descriptions

See the feature table on page 29. For additional information, including configuration, see the PAC Manager User’s Guide.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>States</td>
<td>(Digital input and output)—A digital point is either on or off. You can read the current state of a digital input or write an on/off state to a digital output.</td>
</tr>
<tr>
<td>Latches</td>
<td>(Digital input)—When the value of a digital input point changes from off to on, an on-latch is automatically set. While the value of the point may return to off, the on-latch remains set, as a record of the change, until you clear it. Similarly, an off-latch is set when the value of a digital point changes from on to off, and it remains set until cleared.</td>
</tr>
<tr>
<td>Counters</td>
<td>(Digital input)—A counter keeps track of the number of times a digital input changes from off to on. The count accumulates until it reaches the maximum count available in the brain or until you reset the counter to zero. For example, to count the number of widgets produced per shift, you would clear the counter at the start of each shift and read it at the end of each shift. SNAP-PAC-EB1 and SNAP-PAC-SB1 brains offer high-speed counting (up to 20 KHz) on 4-channel modules; the speed of the counter depends upon the speed of the module used. EB2 and SB2 brains do not offer high-speed counting. All brains can be used with high-density modules (modules with more than four points). These modules offer counting (up to about 50 Hz) within the module.</td>
</tr>
<tr>
<td>Quadrature counters</td>
<td>(Digital input)—A quadrature counter requires a SNAP-PAC-EB1 or SNAP-PAC-SB1 and a SNAP quadrature input module (SNAP-IDC5Q), which can be wired to two encoders. The module sends a pulse to the brain upon each change in quadrature state, and the brain counts the pulses and keeps track of the direction and rotation.</td>
</tr>
<tr>
<td>On-pulse and off-pulse measurement</td>
<td>(Digital input; requires SNAP-PAC-EB1 or SNAP-PAC-SB1 brain with firmware 8.2 or higher, PAC Project Pro 8.2 or higher, and a SNAP PAC controller)—A pulse is a brief on (or off) state, usually repeated at a specific interval. The brain can measure the first pulse, that is, the amount of time the input stays on (or stays off).</td>
</tr>
<tr>
<td>Frequency and Period measurement</td>
<td>(Digital input; requires SNAP-PAC-EB1 or SNAP-PAC-SB1 brain with firmware R8.2 or higher, PAC Project Pro R8.2 or higher, and a SNAP PAC controller)—Frequency is the speed with which a digital point changes state and is usually measured in counts per second. For example, reading the frequency can help you determine the speed of rotating machinery. Period refers to the elapsed time for a complete on-off-on transition on a digital point. Measurement starts on the first transition (either off-to-on or on-to-off) and stops on the next transition of the same type.</td>
</tr>
<tr>
<td>Digital totalizing</td>
<td>(Digital input; requires firmware R8.2 or higher, PAC Project Pro R8.2 or higher, and a SNAP PAC controller)—For a digital input, a totalizer accumulates the total amount of time that a digital input is on (or off). The on-time totalizer shows how long the point has been on; the off-time totalizer shows how long the point has been off. Totalizers are often used to determine maintenance or use schedules.</td>
</tr>
<tr>
<td>Pulse and square wave generation</td>
<td>(Digital output; requires firmware R8.2 or higher, PAC Project Pro R8.2 or higher, and a SNAP PAC controller)—A pulse turns a digital output on (or off) briefly, either once or for a specified number of times at a specified interval. A digital square wave is a specific pattern of on and off states, repeated continuously.</td>
</tr>
<tr>
<td>Time-proportional output (TPO)</td>
<td>Time-proportional output varies the duty cycle and the percentage of on time within that cycle. TPO is often combined with a PID loop and used to control the output, for example in a heater or oven. (Digital output)—Requires firmware R8.2 or higher, PAC Project Pro R8.2 or higher, and a SNAP PAC controller. (Analog output)— Requires a SNAP-AOD-29 module.</td>
</tr>
</tbody>
</table>
## Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Watchdog</strong></td>
<td>(Digital and analog input and output)—A watchdog monitors communication with the PC or other host device. If the host does not write data to the I/O unit for the length of time set in the watchdog, the I/O unit automatically sets designated digital and analog output points to the values you have determined. If communication fails between the host and the brain controlling a process, a watchdog makes sure the process is automatically brought to a safe state. For example, a valve could automatically close to avoid completely emptying a tank.</td>
</tr>
<tr>
<td><strong>Scaling</strong></td>
<td>(Analog input and output)—Analog input and output points can be scaled as needed. For example, you can scale a -5 V to +5 V input point to reflect 0% to 100%</td>
</tr>
<tr>
<td><strong>Minimum and maximum values</strong></td>
<td>(Analog input)—Minimum and maximum values are sometimes called peaks and valleys. You can read these values at any time, for example, to record minimum and maximum temperatures. You can also reset min/max values. For example, if you want to record the maximum temperature at point 2 in each 24-hour period, you must reset the values after they are read each day.</td>
</tr>
<tr>
<td><strong>Thermocouple linearization</strong></td>
<td>(Analog input)—The brain automatically converts the thermocouple junction's millivolt values into temperature values, so you don’t have to. Choose the appropriate module and make sure you configure the point as the correct thermocouple type (E, K, etc.) for your purpose.</td>
</tr>
<tr>
<td><strong>Offset and gain</strong></td>
<td>(Analog input)—Offset and gain calculations are used to calibrate analog points. If a -50 mV to +50 mV input receives signals that are slightly off (not exactly -50 mV at the lowest point, for example), the offset and gain can be calculated so that values will appear accurately when read.</td>
</tr>
<tr>
<td><strong>Clamping</strong></td>
<td>(Analog output)—Clamping limits values that can be sent to analog output points so they do not go above or below a specific value. For example, if you are using a 0–10 VDC output module, but the device attached to one of its points can only handle a maximum of 5 VDC, you can set an upper clamp of 5 VDC for that point. The values for upper and lower clamp are set in engineering units.</td>
</tr>
<tr>
<td><strong>Analog totalizing</strong></td>
<td>(Analog input; requires firmware R8.2 or higher, PAC Project R8.2 or higher, and a SNAP PAC controller) For an analog input, a totalizer accumulates readings by sampling the input point at set intervals and storing the total value, for example to determine total flow based on a varying flow rate signal.</td>
</tr>
<tr>
<td><strong>Ramping</strong></td>
<td>(Analog output; requires firmware R8.2 or higher, PAC Project R8.2 or higher, and a SNAP PAC controller)—Some devices attached to analog outputs should not be abruptly stepped up or down, because a sudden change might damage the equipment or cause other problems. Instead, you can gradually ramp the device up or down to the desired value.</td>
</tr>
<tr>
<td><strong>PID loop control</strong></td>
<td>(Analog points)—Proportional integral derivative (PID) loops are used to drive an input toward a particular value (the setpoint) and keep the input very close to that value by controlling an output. PID loops are often used in temperature control.</td>
</tr>
<tr>
<td><strong>Average filter weight</strong></td>
<td>(Analog inputs)—A filter weight smooths analog input signals that are erratic or change suddenly. See the PAC Manager User’s Guide (form 1704) for details.</td>
</tr>
</tbody>
</table>
### Events, Event Messages, Email, Data Logging

You can configure a SNAP PAC brain to recognize one or a combination of the following as an event:

- The state of a point on a 4-channel digital module (on or off)
- A specific high or low value of an analog point, in Engineering Units
- A number on a digital counter or a high or low number on a quadrature counter
- An analog point value or a quadrature counter that is outside an allowable range
- The state of a bit in the Scratch Pad (on or off)
- A specific string received by a serial module (SNAP PAC Ethernet brains only)

The brain can react automatically to an event in any or all of the following ways:

- Turning points on 4-channel digital modules on or off (same or different brain, immediately or delayed)
- Copying data from one memory map location to another (same or different brain)
- Logging data
- Turning a bit in the Scratch Pad on or off
- Sending a stream packet, an email message, or an SMNP trap (SNAP PAC Ethernet brains only)
- Sending a string through a serial module to a serial device (SNAP PAC Ethernet brains only)

### Security

(SNAP PAC Ethernet brains only) You can limit access to Ethernet brains either by allowing access only from specific computers or other devices on the network (IP filtering), or by limiting access to specific protocols, such as SNMP, that are used with the brain (port access).

### Scratch Pad Areas

The Scratch Pad is used primarily for peer-to-peer communication with other SNAP PAC brains and controllers on the network. See the **PAC Control User's Guide**.

### SNMP

(SNAP PAC Ethernet brains only) The Simple Network Management Protocol (SNMP) is used to communicate with an SNMP-based enterprise management system, such as Computer Associates' Unicenter, Hewlett-Packard's OpenView, or IBM's Tivoli. These systems can manage analog, digital, or serial devices through a SNAP PAC Ethernet brain just as they manage computer equipment on the Ethernet network. The brain is compatible with SNMP v2.0c using brain firmware R8.2a or higher.

### FTP Server

(SNAP PAC Ethernet brains only) SNAP PAC Ethernet brains have a substantial area available for file storage, and data can be easily moved to and from these files using FTP. For details about the file system, see the **PAC Manager User's Guide** (form 1704).
4: Maintenance and Troubleshooting

INTRODUCTION

This chapter includes the following maintenance and troubleshooting information:

Maintenance

Backup Battery
Changing an Ethernet Brain’s IP Address
Resetting a SNAP PAC Brain
Loading New Firmware
Setting Time and Date
Blink Codes

Troubleshooting

Getting Device and Firmware Information
Communicating with an EB Brain
Communicating with an SB Brain
Additional Troubleshooting Tools

MAINTAINING THE SNAP PAC BRAIN

Backup Battery

The real-time clock in the SNAP PAC brain uses a backup battery. This battery is rechargeable and receives a charging current whenever the brain has power. The battery lasts for up to 10 years when power is off.

SNAP PAC EB brains manufactured before July 1, 2007 use a CR2032 lithium backup battery, which is user replaceable. These batteries are readily available in retail stores.
Changing an Ethernet Brain’s IP Address

If you know the brain’s IP address and need instructions to change it, see the PAC Manager User’s Guide (form 1704). If you’re using the brain with an Allen-Bradley system, see the EtherNet/IP for SNAP PAC Protocol Guide (form 1770).

If you do not know the IP address, first check the label on the side of the brain. If you still don’t know the brain’s IP address, follow the steps in the next section to restore the brain to factory default settings, and then assign an IP address as described in the PAC Manager User’s Guide and the EtherNet/IP Guide.

Resetting a SNAP PAC Brain

1. Carefully insert a straightened paperclip or stiff wire into the small hole labeled RESET.
2. Depending on the type of reset you need, press and hold down the RESET button as described below. DO NOT hold the button down too long.

NOTE: Do not reset the brain to hardware test mode unless Opto 22 Product Support tells you to.

<table>
<thead>
<tr>
<th>Reset type</th>
<th>How to use the reset button</th>
<th>What happens</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple reset</td>
<td>Press and release immediately</td>
<td>Brain restarts. Files in RAM are erased. Files in flash memory are untouched.</td>
<td></td>
</tr>
<tr>
<td>Restore factory defaults</td>
<td>Press just until STAT LED turns solid green (1-2 sec)</td>
<td>Brain restarts. Files in RAM and flash memory are erased. I/O configuration in flash is erased. IP address is reset to 0.0.0.0 and subnet mask to 255.255.255.0. You have to reassign the IP address and subnet mask.</td>
<td></td>
</tr>
<tr>
<td>Failsafe bootloader mode</td>
<td>Press and wait until LED turns solid green. Release when LED starts to blink (2-5 sec)</td>
<td>Brain restarts. Files in RAM are erased. Files in flash memory are untouched. Cycle power to recover. Result is the same as a simple reset.</td>
<td></td>
</tr>
<tr>
<td>Hardware test mode</td>
<td>Press and hold until LED starts blinking orange rapidly and continuously (&gt; 5 sec)</td>
<td>Brain restarts. Files in RAM and flash memory are erased. I/O configuration in flash is erased. IP address is reset to 0.0.0.0 and subnet mask to 255.255.255.0. Cycle power to recover. Result is the same as restoring to factory defaults. You have to reassign the IP address and subnet mask.</td>
<td></td>
</tr>
</tbody>
</table>

Loading New Firmware

Each SNAP PAC brain contains firmware (sometimes referred to as the kernel), which is similar to an operating system. If the firmware should become damaged, or if a new version of the firmware is released, you can load new firmware to the brain following instructions in the PAC Manager User’s Guide (form 1704).

Setting Time and Date

The SNAP PAC brain’s built-in clock is set at the factory. To change the time and date, see instructions in the PAC Manager User’s Guide (form 1704).
Blink Codes

LEDs on the top of a SNAP PAC brain use blink codes to indicate operation and status. For the location of LEDs, see “LEDs and Network Interfaces—Ethernet Brains (Obsolete)” on page 28 or “LEDs and Network Interfaces—Serial Brains (Obsolete)” on page 29. Blink codes provide useful information during operation and in troubleshooting.

Self-Test LED Sequence at Startup

When you first turn on the brain, you’ll see the following LED sequence. This is a self test.

<table>
<thead>
<tr>
<th>Duration (seconds)</th>
<th>MS LED</th>
<th>NS LED</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.25</td>
<td>Green</td>
<td>Off</td>
</tr>
<tr>
<td>0.25</td>
<td>Red</td>
<td>Off</td>
</tr>
<tr>
<td>0.25</td>
<td>Green</td>
<td>Green</td>
</tr>
<tr>
<td>0.25</td>
<td>Off</td>
<td>Off</td>
</tr>
<tr>
<td>0.25</td>
<td>On</td>
<td>Flash On</td>
</tr>
</tbody>
</table>

Normal LED Behavior: MS and NS LEDs

Once the self-test is finished, normal LED behavior is as shown in the following tables.

**MS LED—Applies only when using EtherNet/IP**

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady Off</td>
<td>No power</td>
</tr>
<tr>
<td>Steady Green</td>
<td>Operational. Device has been configured and can operate normally.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Standby. Device does not have a valid IP configuration.</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>Minor fault. A recoverable fault has occurred.</td>
</tr>
<tr>
<td>Steady Red</td>
<td>Major fault. A non-recoverable fault has occurred.</td>
</tr>
</tbody>
</table>

**NS LED**

<table>
<thead>
<tr>
<th>LED</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Steady Off</td>
<td>The device does not have a valid IP address or has no power.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>EtherNet/IP only: No connections</td>
</tr>
<tr>
<td>Steady Green</td>
<td>EtherNet/IP only: Connected</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>EtherNet/IP only: Connection Timeout</td>
</tr>
</tbody>
</table>
STAT LED—Green

If the STAT LED is on and remains green, the brain is operating normally. On an EB brain, a solid green LED indicates that the brain has an IP address.

If the STAT LED blinks green when the brain starts up, it indicates the following:

<table>
<thead>
<tr>
<th>Number of Blinks</th>
<th>Speed of Blinks</th>
<th>Means</th>
<th>Problem and Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>fast</td>
<td>Normal; the brain’s firmware is starting up.</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>fast</td>
<td>Default settings have been successfully restored.</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>fast</td>
<td>Entering failsafe bootloader mode. For details, see “Resetting a SNAP PAC Brain” on page 36.</td>
<td></td>
</tr>
</tbody>
</table>

STAT LED—Orange

On an EB brain, if the STAT LED blinks orange about four times a second, the device is attempting to obtain an IP address by sending BootP requests.

On an SB brain, you can enable special orange blink codes to troubleshoot communication. See page 45 for more information.

On both EB and SB brains, if the STAT LED blinks orange fast and continuously after you pushed the RESET button, the device is in hardware test mode (see page 36).

STAT LED—Red and Green

If the STAT LED blinks red and green alternately, it indicates that the brain is in failsafe bootloader mode. See “Resetting a SNAP PAC Brain” on page 36 for more information.

STAT LED—Red

If the STAT LED blinks red, it indicates the following:

<table>
<thead>
<tr>
<th>Number of Blinks</th>
<th>Speed of Blinks</th>
<th>Means</th>
<th>Problem and Workaround</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>slow</td>
<td>(SB brain) Incorrect serial settings (Both brains) Invalid MAC address or hardware revision</td>
<td>(SB brain) Check serial settings (See page 10.) Contact Product Support.</td>
</tr>
<tr>
<td>5</td>
<td>slow</td>
<td>Fatal error</td>
<td>Firmware or hardware problem. Check the power supply and connections before restarting. Call Product Support if the error is repeated.</td>
</tr>
<tr>
<td>6</td>
<td>slow</td>
<td>RAM error</td>
<td>Contact Product Support.</td>
</tr>
<tr>
<td>7</td>
<td>slow</td>
<td>Ethernet switch failure</td>
<td>(EB brain only) Contact Product Support.</td>
</tr>
<tr>
<td>11</td>
<td>slow</td>
<td>Ethernet loopback test failure</td>
<td>(EB brain only) Contact Product Support.</td>
</tr>
<tr>
<td>13</td>
<td>slow</td>
<td>Real-time clock failure</td>
<td>Contact Product Support.</td>
</tr>
<tr>
<td>16</td>
<td>slow</td>
<td>Serial flash failure</td>
<td>Contact Product Support.</td>
</tr>
<tr>
<td>20</td>
<td>slow</td>
<td>Digital failure</td>
<td>Contact Product Support.</td>
</tr>
<tr>
<td>21</td>
<td>slow</td>
<td>Bus failure</td>
<td>Contact Product Support.</td>
</tr>
</tbody>
</table>
CHAPTER 4: MAINTENANCE AND TROUBLESHOOTING

GETTING DEVICE AND FIRMWARE INFORMATION

If you need to contact Opto 22 Product Support for assistance, it’s helpful to have device and firmware information at hand before you call us. Here’s how to get that information for SNAP PAC brains:

1. Start PAC Manager.
   
   Click the Windows Search button and type PAC Manager 10.0.

2. In the PAC Manager main window, click the Inspect button.

3. In the Device Name field, enter the name of the brain (usually the I/O unit name configured in PAC Control) or choose the name from the drop-down list.

4. If the brain has already been defined in PAC Manager, skip to step 7.
   
   If the brain has not been defined, the Add New Device dialog box appears.
5. Choose the Connection Type.
   a. For an EB brain, click Direct Connection to Ethernet Device.
      - Enter the IP address of the brain.
      - Leave the Ethernet port at 2001 unless you have changed it on the brain.
   b. For an SB brain connected directly to a PC (not to a controller), click Direct Connection to Serial Device.
      - Make sure the PC’s port is correct and that the baud rate matches that of the brain.
      - Enter the brain’s address.
   c. For an SB brain connected to a SNAP PAC controller, click Pass-Through Ethernet Controller to Serial Device.
      - Enter the IP address of the controller.
      - Leave the controller’s Ethernet port as 2001 unless you have changed it.
      - Enter the controller’s serial port. On a SNAP-PAC-S1 controller, choose Serial 2. On a SNAP-PAC-S2, choose the port the brain is connected to.
      - Make sure the controller’s baud rate matches that of the brain.
      - Enter the brain’s address. If you are using a 2-wire connection, check 2-Wire RS-485.
   d. If network timing isn’t working, change the Timeout value in the upper right.

6. Click OK.

7. In the Inspect Opto 22 Device window, click the Status Read button in the upper left. Information from the brain is displayed in the window.
In this example, we configured a SNAP-PAC-SB1 using a Pass-Through connection.

Keep this window open on your screen when you call Product Support.
For explanations of the data shown, see the PAC Manager User's Guide (form 1704).

TROUBLESHOOTING SNAP PAC BRAINS

If you encounter a problem while installing or using SNAP PAC brains, these sections may help.
- For SNAP PAC EB brains, see the next section.
- For SNAP PAC SB brains, see page 44.

If you need to contact Opto 22 Product Support, see “For Help” on page 4.

Communicating with an EB Brain

If you attempt to connect to the brain using its IP address and you cannot, first check the following:
- Make sure the brain has been turned on and the LNK and STAT LEDs for the connected Ethernet interfaces are lit (see “LEDs and Network Interfaces—Ethernet Brains (Obsolete)” on page 28.)
- If the brain has been networked in a daisy-chain configuration, check to see if another brain in the chain has lost power. Also make sure all network connections are correct. (See “Using SNAP PAC Ethernet Brain Network Interfaces” on page 26.)
- Make sure the brain’s hold-down screw has been tightened so that it is firmly attached to the rack. (Do not overtighten.)
- Verify that you typed in the correct address for the brain. Check the label on the side of the brain, where the IP address should be written.
- Make sure the brain has been assigned a valid IP address and subnet mask. SNAP PAC brains come from the factory with a default IP address of 0.0.0.0, which is invalid. The default subnet mask is 255.255.255.0. To assign an IP address and subnet mask, see the PAC Manager User's Guide (form 1704).
• Make sure that no red LEDs on the brain are lit. A red LED could indicate a voltage supply problem. Each brain should have its own power supply. The brain needs a minimum of 5.0 VDC, measured at the rack.

• Make sure you have up-to-date drivers installed on your computer’s Network Interface Card (NIC). Contact your system administrator or the manufacturer of the card for help.

• Make sure you have Administrator privileges on your computer and that any firewall in the computer is temporarily disabled before you try to assign or change IP addresses, load firmware using PAC Manager’s Maintenance window, or work with files on the brain. BootP and FTP cannot function through a firewall in the PC. Firewalls in a router are less likely to be a problem.

Pinging the Brain

If you still cannot communicate with the brain after you have checked these items, try to reach it using the PING protocol.

1. Choose Start > Programs > Accessories and open a command prompt window.
2. At the prompt, type: ping [brain’s IP address]
   For example, type: ping 10.192.54.40

If the brain responds, go to “Accessing the Ethernet Brain with PAC Manager” on page 42.

If the PING command cannot be found, choose Start > Control Panel > Network. Make sure TCP/IP is configured as a protocol and that an IP address and subnet mask are assigned.

If you see the message “Destination host route not defined,” the brain probably has an inappropriate IP address and subnet mask. Make sure the IP address and subnet mask on the brain are compatible with those on the computer. Follow the directions beginning on page 36 to check the IP address and subnet mask on the brain, and change them if necessary.

If you see the message “No response from host,” check the following:
• Are the computer and brain correctly connected? Is the brain turned on?
• Are the IP address and subnet mask on the brain compatible with those on the computer?
• Is the brain in reset mode? (Check for a blinking STAT LED. STAT blink codes are shown on page 37.)

If you still cannot ping the brain, contact Opto 22 Product Support. (See page 4.)

Accessing the Ethernet Brain with PAC Manager

Once you know you can ping the brain, try to access it using PAC Manager. You will need to know the brain’s IP address.

1. Start PAC Manager.

Click the Windows Search button and type PAC Manager 10.0.
2. In the PAC Manager main window, click the Inspect button.
3. In the Device Name field, enter the name of the brain or choose the name from the drop-down list. (You can also type in the brain’s IP address.)
4. Click Status Read.

Information from the brain is displayed in the window:

If information does not appear, contact Product Support. (See page 4.)

Solving Ethernet Network Problems

If there are recurring problems in communicating with the brain, check your network. The cables, routers, and so on in your Ethernet network are not part of the Opto 22 hardware, but any problems in your network may affect communication with Opto 22 products.

Create a Network Diagram—First, create a network diagram and verify the following:
- Cable connectors are firmly inserted.
- The Ethernet network switch has power. Switch LEDs indicate that the connection is up. If SNAP PAC brains are daisy-chained, LNK LEDs for both of their Ethernet interfaces are lit.
- Neither the PC nor the brain uses the switch’s uplink port.
- The two switched network interfaces on the brain are being used correctly and are not creating a loop anywhere in the network (see "Using SNAP PAC Ethernet Brain Network Interfaces" on page 26).
- The brain’s LNK LED(s) are lit.

Check Ethernet Errors—Next, use PAC Manager to check Ethernet errors reported by the brain. These errors indicate network problems. You will need to know the brain’s device name (usually the same as the I/O unit in PAC Control) or its IP address.

1. Choose Start > Programs > Opto 22 > PAC Project Software > PAC Manager.
2. In the PAC Manager main window, click the Inspect icon.
3. In the Device Name field, type the brain’s name (or IP address). Click Status Read.
4. Scroll down until you see the items Ethernet Errors: Late Collisions, Ethernet Errors: Excessive Collisions, and Ethernet Errors: Others.
All three of these items should have a value of zero. If any of these items has a value other than zero, you may have a network problem.

**Analyze Communication Packets**—If it appears that you have network problems, you can use a utility program such as Wireshark (www.wireshark.org) to log and analyze network communication packets.

**Have Your Network Certified**—If you suspect network problems, you may need to have your network professionally certified. Opto 22 does not offer network validation or certification services, but many network hardware manufacturers do. Contact the manufacturer of your Ethernet network hardware to have them diagnose, fix, and certify your network.

If you continue to have problems communicating with the SNAP PAC brain after your network is certified, contact Opto 22 Product Support. (See page 4.)

**Communicating with an SB Brain**

If you are having trouble communicating with the SNAP PAC serial brain, check the following:

- Make sure the brain has been turned on and that the STAT LED is lit (green).
- Make sure the brain’s hold-down screw has been tightened so that it is firmly attached to the rack. (Do not overtighten.)
- If you’re accessing the brain through a SNAP PAC S-series controller, make sure you can communicate with the controller over Ethernet. For help, see the **SNAP PAC S-Series Controllers User’s Guide** (form 1592).
- Check physical connections between the controller or PC and the brain.
- Verify that the following serial parameters on the controller or PC and the brain correspond: baud rate, address, 2-wire or 4-wire connections.
- Make sure termination switches are set correctly for all brains on the serial network.
- Make sure that power to the brain is sufficient. Each brain should have its own power supply. The brain needs a minimum of 5.0 VDC, measured at the rack.
CHAPTER 4: MAINTENANCE AND TROUBLESHOOTING

Timeout Errors when Communicating via a Controller

- To avoid timeout issues when communicating from a controller to a serial brain, you should configure matching turnaround delays in both the controller and the brain. (Turnaround delays are typically required at 9600 baud—and sometimes needed at higher baud rates when your RS-485/422 bus is using repeaters.)
  - Configure the controller’s turnaround time in PAC Manager > Tools > Inspect > Status Write button > Turn-Around Delay for Port <#> (msec).
  - Configure the same turnaround time for the brain in PAC Manager > Tools > Inspect > Status Write button > Turn-Around Delay for Port <#> (msec).

  The amount of turnaround time you’ll need depends on the RS-485 cable connecting the devices (turnaround time increases with the length of the cable). Start with a 1 millisecond delay, and then, if you’re still experiencing issues, increase the turnaround time until the connection is satisfactory.

- If you get a timeout error when trying to establish communication between an S-series controller and a serial brain (for example, a SNAP-PAC-SB2), the problem could be configuration-related.
  - If you get the error when trying to run a PAC Control strategy, make sure that the baud rate on the brain’s Baud Rate Switch is the same as the baud rate configured in your PAC Control strategy (File > Strategy Options > Serial I/O Ports tab). For example, if the brain’s baud rate is set at 115,200 Kbs, then the serial I/O (RS-485) port in your strategy must also be configured for 115,200 Kbs.
  - If you get a timeout error when using PAC Manager to communicate with the brain via a controller:
    a. Check that the baud rate setting on the brain is the same as the baud rate configured in PAC Manager (Tools > Inspect > Communications > PPP Configure > Serial Port Speed).
    b. If that doesn’t solve the problem, then make sure the brain’s baud rate setting is the same as the baud rate in the controller’s strategy (File > Strategy Options > Serial I/O Ports tab).

When you’ve configured the same baud rate for the brain, the strategy, and PAC Manager, you then need to cycle power to the controller. Cycling power releases a lock previously put on the configured communication port, and allows the new connection to succeed.

Turning on Communication Error Blink Codes (Serial Brain)

To troubleshoot communication with the SB brain, you can turn on communication error blink codes following the steps below.

*NOTE: Turn on blink codes only for debugging purposes; they will degrade performance.*

1. Start PAC Manager.

Click the Windows Search button and type PAC Manager 10.0.

2. In the PAC Manager main window, click the Inspect button.

3. In the Device Name field, enter the name of the SB brain or choose it from the drop-down list (for help, see page 39).

4. Click the Status Write button.
5. Click the Value field for Communication Error Blink Codes.

![Image of the SNAP PAC Brains software interface]

6. From the drop-down list, choose Enabled. Click the Apply button.

Once you’ve turned on communication error blink codes, the STAT LED blinks orange (a combination of red and green) to indicate the following:

<table>
<thead>
<tr>
<th>Number of Blinks</th>
<th>Speed of Blinks</th>
<th>Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 fast</td>
<td></td>
<td>Serial communication CRC error</td>
</tr>
<tr>
<td>3 fast</td>
<td></td>
<td>Incorrect serial packet type</td>
</tr>
<tr>
<td>4 fast</td>
<td></td>
<td>Malformed serial packet. Did not receive entire packet.</td>
</tr>
<tr>
<td>5 fast</td>
<td></td>
<td>OptoMMP application error</td>
</tr>
<tr>
<td>6 fast</td>
<td></td>
<td>UART Receive error</td>
</tr>
<tr>
<td>7 fast</td>
<td></td>
<td>UART Send error</td>
</tr>
<tr>
<td>8 fast</td>
<td></td>
<td>Packet address doesn’t match brain’s address</td>
</tr>
</tbody>
</table>

**IMPORTANT:** Don’t forget to disable communication error blink codes when you’ve finished troubleshooting.
ADDITIONAL TROUBLESHOOTING TOOLS

Making Sure the Brain is in Normal Mode

If you are having trouble communicating with the brain, it might be in *failsafe bootloader mode* or *hardware reset mode*. The brain restarts in one of these modes if you hold down the RESET button longer than the time needed to restore default settings. For more information on using the RESET button, see “Resetting a SNAP PAC Brain” on page 36.

- **Failsafe bootloader mode** is a diagnostic mode you normally use only when an Opto 22 Product Support engineer suggests it. You’ll know if the brain is in this mode because the STAT LED blinks green seven times, quickly. If your brain restarts in failsafe bootloader mode, simply cycle power to the device. The brain will restart, and you should be able to communicate with it.

- The brain enters **hardware reset mode** if you hold down the RESET button for more than five seconds. At that point the STAT LED blinks orange quickly and continuously. This mode erases any files in RAM and flash memory and puts the brain into a continuous testing loop. If your brain is in hardware reset mode, cycle power to it, and it will restart as if you had reset it to factory defaults. On an EB brain, you’ll need to reassign an IP address and subnet mask.

TCP Settings (Ethernet Brains)

Retransmit timeout (RTO) refers to the length of time the controller waits while communicating before timing out. The RTO is determined by the controller’s TCP/IP stack, and the stack continually recalculates the RTO based on recent network traffic. If the network becomes busier, for example, the stack automatically adjusts the RTO to a higher value.

If the TCP/IP stack times out while trying to transmit data, it doubles the current RTO and tries again. This process continues for five retries; after that, the device stops trying and sends a timeout message.

If you are receiving frequent timeout messages from the device, you can change the TCP parameters in PAC Manager.

1. Start PAC Manager:
   - Click the Windows Search button and type PAC Manager 10.0.
2. In the PAC Manager main window, click the Inspect icon.
3. In the Device Name field, type the name or IP address of the controller.
   - Then, click Status Write.
**CAUTION:** Note the following recommended settings:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP Minimum Retransmission Timeout (msec)</td>
<td>250</td>
</tr>
<tr>
<td>TCP Initial Retransmission Timeout (msec)</td>
<td>3000</td>
</tr>
<tr>
<td>TCP Retransmission Attempts</td>
<td>5</td>
</tr>
<tr>
<td>TCP Idle Session Timeout (msec)</td>
<td>240,000</td>
</tr>
</tbody>
</table>

If you set these fields too low, you may not be able to communicate with the device at all—even through PAC Manager—to fix the settings. Then you would have to reset the controller to factory defaults.

4. Change these four fields as necessary:
   - **Minimum RTO** sets an absolute minimum value for the RTO. The device’s calculated RTO will never go below this value.
   - **Initial RTO** sets the RTO for the first communication try. Be careful: since all future tries are based on this value, if you set it too low for network conditions, a connection will never be made.
   - **TCP Retransmits** sets the number of times the device retries communication. Larger, busier networks need a higher number of retransmits than smaller networks with less traffic.
   - **TCP idle session timeout** sets how long (in milliseconds) the device allows a session to remain open without any activity. After this time, the device checks the session to make sure it is still good, and closes it if it is not. The default is 240,000 milliseconds, or four minutes.

5. Click the Apply button to write your changes to the controller.

6. In the Operation Commands list, highlight Store configuration to flash. Click Send Command.

7. In the Operation Commands list, highlight Restart brain from powerup. Click Send Command. The new TCP parameters are set.
A: Serial Cables and Addressing

SERIAL CABLES

The following cables are recommended for RS-485 serial communications. Although you may elect to use other cables, keep in mind that low capacitance (less than 15 pF/ft.) is important for high-speed digital communication links. The cables listed below are all 24-gauge, 7x32 stranded, with 100 ohm nominal impedance and a capacitance of 12.5 pF/ft.

Select from the following two-, three-, and four-pair cables, depending on your application needs. All will yield satisfactory results. We recommend that you choose a cable with one more pair than your application requires. Use one of the extra wires, rather than the shield, for the common.

Two-Pair:
Belden P/N 8102 (with overall shield)
Belden P/N 9729 (individually shielded)
Belden P/N 8162 (individually shielded with overall shield)
Manhattan P/N M3475 (individually shielded with overall shield)
Manhattan P/N M39249 (individually shielded with overall shield)

Three-Pair:
Belden P/N 8103 (with overall shield)
Belden P/N 9730 (individually shielded)
Belden P/N 8163 (individually shielded with overall shield)
Manhattan P/N M3476 (individually shielded with overall shield)
Manhattan P/N M39250 (individually shielded with overall shield)

Four-Pair:
Belden P/N 8104 (with overall shield)
Belden P/N 9728 (individually shielded)
Belden P/N 8164 (individually shielded with overall shield)
Manhattan P/N M3477 (individually shielded with overall shield)
Manhattan P/N M39251 (individually shielded with overall shield)

ADDRESS TABLE

Serial addresses from 0–255 can be used for serial-based SNAP PAC brains. The brain’s address is set using the two rotary switches on the top of the brain, as shown on page 10. The table on the following page shows switch settings for each address.
<table>
<thead>
<tr>
<th>Address</th>
<th>Hex equivalent</th>
<th>Address upper</th>
<th>Address lower</th>
</tr>
</thead>
<tbody>
<tr>
<td>31 1F 1F</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>30 1E 1E</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>29 1D 1D</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>28 1C 1C</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>27 1B 1B</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>26 1A 1A</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>25 19 19</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>24 18 18</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>23 17 17</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>22 16 16</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>21 15 15</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>20 14 14</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>19 13 13</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>18 12 12</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>17 11 11</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>16 10 10</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>15 9 9</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>14 8 8</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>13 7 7</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>12 6 6</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>11 5 5</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>10 4 4</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>9 3 3</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>8 2 2</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>7 1 1</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
</tbody>
</table>

**Serial Address Table—SNAP PAC SB Brains**
Index

A
accessing brain over the Internet, 19
ACT LED, 28
address for serial brain, 49
Allen-Bradley PLC, communicating with, 17, 22
analog point
  average filter weight, 32
  clamping, 32
  gain, 32
  maximum value, 32
  minimum value, 32
  offset, 32
  PID loop control, 32
  ramping, 32
  scaling, 32
  totalizer, 32
  TPO, 31
  watchdog, 32
  average filter weight, 32

B
baud rate, 10
blink codes, 37
  SB brain communication, 45
brain
  comparing features, 29
  Ethernet networking, 25
  FTP, 33
  installing, 9
  Scratch Pad, 33
  serial networking, 10

C
calibrating analog point, 32
clamping analog output point, 32
communicating
  choosing methods, 20
  with Ethernet brain, 17
    pinging the brain, 42
    problems with, 41
    simultaneously, 18
  with serial brain, 18
    blink codes, 45
    troubleshooting, 44
  communication error blink codes, 45
  comparing brain features, 29
  computer, connecting directly to EB brain, 25
  computer, connecting directly to serial brain, 24
  connecting to brain
    daisy-chaining, 26, 27
    Ethernet network interfaces, 26
    serial wiring diagrams, 12
    troubleshooting EB brain, 41
    troubleshooting SB brain, 44
  counter, description, 31

D
daisy chain, 26, 27
data logging, 33
data mirroring, 33
database connectivity, 18, 19
default settings, restoring, 36
digital point
  counter, 31
  latching, 31
  quadrature counter, 31
  state, 31
  totalizer, 31
  TPO, 31
  watchdog, 32
direct connection
  Ethernet, 25
  serial, 24
distributed system, 21
email, 33
enterprise management system, 33
Ethernet brain
  communication, 17
  troubleshooting, 41
Ethernet network
  accessing brain over the Internet, 19
  architecture, 25
  attaching brain to existing network, 25
  certification, 44
  daisy-chaining brains, 26
  errors, 43
  incorrect connections (diagram), 27
  independent control network, 25
  interfaces, 26, 28
  troubleshooting, 43
EtherNet/IP, 17
  event, 33
  event messages, 33

failsafe bootloader mode, 36, 47
features
  comparison of brain models, 29
  descriptions of, 31
file system on brain, 33
firmware, loading, 36
frequency measurement, 31
FTP, 18, 33

gain, definition, 32
generating
  pulse, 31
  square wave, 31

hardware, getting data about, 39
help
  blink codes, 37
  Ethernet network problems, 43
  LED descriptions, 28, 29
  Product Support, 4
  high-density digital counter, 31

I/O modules
  installing, 7
  removing, 9
I/O point features, 31
I/O processor
  Ethernet brain used independently, 23
  serial brain used independently, 24
installing
  brain on rack, 9
  I/O modules, 7
  mounting rack, 7
  quick start, 7
Internet, accessing brain over, 19
IP filtering, 33
IRQ LED, 29

latch, definition, 31
LEDs
  blink codes, 37, 45
  description, 28, 29
  red, 42
LNK LED, 28
loop control on analog point, 32

maximum value, 32
measuring
  frequency, 31
  period, 31
  pulses, 31
memory map copying, 33
minimum value, 32
Modbus/TCP, 18
mounting rack, installing, 7

network
  attaching EB brain to existing network, 25
  certification, 44
  daisy-chaining brains, 26
  Ethernet errors, 43
  Ethernet interfaces, 26, 28
  incorrect Ethernet connections (diagram), 27
  independent Ethernet network, 25
  serial port, 29
  termination, 12
  troubleshooting Ethernet, 43
O
off-latch, 31
off-pulse measurement, 31
offset, definition, 32
off-time totalizer, 31
on-latch, 31
on-pulse measurement, 31
on-time totalizer, 31
OPC, 4, 18, 19
Opto 22 Product Support, 4
OptoDataLink, 4, 18, 19
OptoOPCServer, 18, 19

P
PAC Control, 17, 19
PAC Manager, 3, 17, 19
PCI-AC48 adapter card, 24
peak, 32
period measurement, 31
PID loop control, 32
ping, 42
port access, limiting, 33
Product Support, 4
pulse
  generation, 31
  measurement, 31

Q
quadrature counter, 31
quick start, 7

R
rack for I/O modules, installing, 7
ramping analog output point, 32
removing I/O modules, 9
RESET button, 36, 47
restoring default settings, 36
retransmit timeout (RTO), 47
RSTP, 27

S
scaling, description, 32
Scratch Pad areas, 33
security, 33
serial brain
  addressing, 49
  cables, 49
  communication, 18
  installation, 10
  troubleshooting, 44
  wiring diagrams, 12
SERIAL LED, 29
serial network, 10
  addressing, 49
  port, 29
  wiring diagrams, 12
SMTP, 18
SNAP PAC System Illustration, 21
SNAP-PAC-EB1, features, 29
SNAP-PAC-EB2, features, 29
SNAP-PAC-SB1, features, 29
SNAP-PAC-SB2, features, 29
SNMP, 18, 33
square wave generation, 31
STAT LED, 28, 29
state of digital point, 31
status conditions (blink codes), 37
STP, 27
system architecture, 25

T
TCP/IP
  multiple sessions, 18
  settings, 47
  stack, 47
technical support, 4
termination, 12
termination and bias, 10
thermocouple linearization, definition, 32
timed event, 33
timeout, 47
time-proportional output, 31
totalizer
  analog, 32
digital, 31
TPO, 31
troubleshooting
  blink codes, 37
  Ethernet brain, 41
  Ethernet network, 43
  LED descriptions, 28, 29
  Product Support, 4
  serial brain, 44

V
valley, 32
W

watchdog, definition, 32
wiring diagrams
  serial brain, 12